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1: Web Page Maker - ØªÙ†Ø²ÙŠÙ„
Web Page Maker is an easy-to-use web page editor that allows you to create and upload web pages in minutes without
knowing HTML. Simply drag and drop objects onto the page and position them freely in the layout.

What You Can Do with a WordProcessor Microsoft Word has rudimentary facilities to make it slightly easier
for you to put an existing document onto your website. It can convert your document into a web page so that it
can be displayed like a normal web page in a browser. You can create links that point to other websites or
other pages on your own website. This can be done either automatically by Word when you type a web
address like "http: My guess is that the facilities are primarily meant for people with existing documents which
they want to place on the Internet, and not really meant for someone who wants to create and maintain an
entire website from scratch. You will lose the ability to embed code supplied by other websites into your web
page. Some sites, including thesitewizard. For example, there are numerous free web statistics services that
you can use so that you can find out how many visitors are using your website and so on. Such services
typically require you to insert some type of code into your web page. You will not be able to easily publish
your document to your website from within your wordprocessor. Word also does not provide an easy way for
you to update and change the design of all the pages on your website should you decide to change it in the
future. If you have many pages on your website, and you decide that you want to change the design, you will
have to manually change them on every page yourself. To be fair though, only commercial web editors like
Dreamweaver have this facility. At the time I write this, the free KompoZer web editor does not do this either.
To create links to other web pages, do the following. If you use Word , just skip to the Word section. If you
use Word or , just read that section. The 2 sections are written to be independent of each other. Type the text
you want into your document in the usual way, and select it. Click the "Insert" tab at the top of the Word
window. A new set of buttons will appear below "Insert". Click the "Hyperlink" button. A dialog box labelled
"Insert Hyperlink" will appear. Type the web address into the "Address" field. For example, the web address
of this article is "https: Click the "OK" button. The text you selected should now appear as a blue underlined
link in your document. How to Create a Link in Word ie, from Microsoft Office To make some piece of text
into a link, select the text in your document in the usual way. Drag your mouse over those words or use the
Shift key together with the arrow keys to select them. Then click the "Insert" menu, followed by the
"Hyperlink" item that appears in that menu. A dialog box entitled "Insert Hyperlink" should appear. Type the
web address you want into the "Address" field. For example, the address of this article is "https: If you have
done it correctly, the text you selected should now be underlined and appear in blue, the way many links on
the web do. To do this, if you are using Word or , click the "File" menu. If you are using Word , click the
nameless round button at the top left of the Word window. Once the "Save As" dialog box appears, type the
name of the file you want to save as in the "File name" box. For example, if you are making the main page of
your website, you should call the page "index" without the quotes. Then click the "Save as type" drop down
box to expand it. There are two possible options that you can use to create HTML files ie, web page files. The
"Web Page, Filtered" option creates smaller and more standard web pages that contain only the formatting
code understood by web browsers and search engines. This additional code is hopefully ignored by web
browsers and search engines, but is used interally by Word when you open that same file again to edit it. For
example, some facilities may be disabled. It will probably also be more bloated than it needs to be. A dialog
box, called "Set Page Title", will appear. This page title is the title of your web page that you see in the search
engine listings of your website. It also appears in the top menu bar of the browser window when you view
your web page in a web browser. It is not displayed in your document, but is an important part of a web page.
Type an appropriate title for your web page here and click the "OK" button. Next, if you use Word or , click
the "Tools" button at the bottom of the dialog box, and select "Web Options". Before you proceed, notice that
Word has changed your filename to add ". For example, if you typed "index", the file will now be called
"index. Change it so that the ending is ". That is, if Word has changed it to "index. Finally, click the "Save"
button in the "Save As" dialog box. Word saves your file along with an additional folder containing any
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embedded pictures you have in your document as well as some other data. You will have to publish both your
file and this additional folder and its contents to your website. As mentioned earlier, such a program is called
an FTP client. You have to make do with a lot of limitations. However, in a pinch, it is possible to create a
rudimentary web page if you need to. Get more free tips and articles like this , on web design, promotion,
revenue and scripting, from https: You can learn of new articles and scripts that are published on
thesitewizard. Please do not reproduce or distribute this article in whole or part, in any form.
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2: HTML Responsive Web Design
Web Page Maker is an easy-to-use web page design tool that allows you to create and upload a professional web page
in minutes without having to know HTML.

Live customer support from people who really care. WebStarts is everything you need to create and maintain
your very own website. Traditionally websites are written in HTML code, that code is stored on a server, and a
domain is pointed to it. The process of setting up a traditional website is tedious, technical, and expensive.
Next, you need to purchase server space. Finally, you need to register a domain. The whole process is so
confusing it leaves a lot of people wondering how to make a website at all. Web hosting WebStarts hosts your
website in the cloud. Domain names When you create a website with Webstarts you can add a domain name to
your website and it starts working instantly. Just log in and everything is drag and drop. Nothing could be
easier. How Is WebStarts different from other website builders? Most website builders limit you to choosing
from one of the same boring templates already being used by hundreds, if not thousands of other websites.
Then their idea of customization is allowing you to swap out text and align it left, center, and right. In
addition, WebStarts is jam packed with powerful features that would cost extra with our competitors. All of
this is backed up with live support, based right here in the USA. Our friendly and knowledgeable staff is
happy to help bring your website to completion. It sounds great, so how can WebStarts be free? When we
started WebStarts we knew everyone was going to need a website, that means everyone. Knowing the wide
range of uses for a website we decided to make the basic version of WebStarts free. That way everyone from
the student to the biggest corporation can create a great looking website with our free website builder. A
website builder that helps you get found. At WebStarts we know the most important thing for most people
who create a website is getting found. That means websites created with WebStarts are more likely to be found
on search engines like Google. So when you make a website with WebStarts rest assured people are going to
be able to find the website you created online. A free website builder with the features you need to succeed
online. While our competitors limit you to creating a boring static website, at WebStarts we give you the
ability to build a website that includes rich, interactive features, we call them apps. Our integrated apps range
from form builders, calendars, memberships, video hosting, music playlists, music stores, maps, SEO, and
much more. These interactive apps are designed to help your website attract more visitors, capture more leads,
and make your website more sticky. How to create a website with WebStarts Watch this short video to see
how easy it is to start creating your very own website with WebStarts.
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3: How to Create a Simple Web Page With HTML (with Examples)
Wix Editor Total Design Freedom. Start with a blank slate or choose from over designer-made templates. With the
world's most innovative drag and drop website builder, you can customize anything you want.

Typically, the HTML file includes associations with other files that either appear on the web page or govern
how it looks or works. The resulting PDF behaves much like the original web page. For example, the images,
links, image maps, and most media files appear and function normally within the PDF. Animated GIF files
appear as still images, showing the last frame of the animation. For example, you can navigate through the file
by scrolling or using bookmarks; users can add comments to it; you can add security, form fields, and other
features that enhance it. In preparing to convert web pages to PDF, consider the following factors, which
affect how you approach the conversion process: How much do you want to convert? If you want to convert
only selected areas of the currently open web page, use PDFMaker from within Internet Explorer. If you want
to convert several levels or all of a multipage website to PDF, work within Acrobat. You can do both in either
Acrobat or Internet Explorer, but you choose different buttons or commands to accomplish these things. Also,
it is preferable to select an appropriate encoding from the HTML conversion settings. Using the commands on
this toolbar, you can convert the currently displayed web page to PDF in various ways. For example, you can
convert the entire web page or selected areas of it. The toolbar has additional commands that initiate further
actions after conversion, such as attaching the new PDF to a new email message or printing it. A menu on the
PDF toolbar provides easy conversion and print capabilities. Go to the web page. For Mac, use Firefox. Then
select a location, type a filename, and click Save. Then locate and select the existing PDF, and click Save.
When the conversion is complete and the Print dialog box opens, specify options and click OK. Then specify a
location and filename for the PDF, and click Save. Type the appropriate information in the email message that
opens after the conversion is complete. Right-click on the selected content and choose one of the following:
Then select a name and location for the PDF. Then locate and select the PDF to which the selection will be
added. Convert selected areas in a web page to PDF Internet Explorer only You can use the Select option to
select specific areas on a web page to convert. You can use this option to convert meaningful content on a web
page and omit unwanted content, such as advertisements. As you move the pointer around the web page, a red
dotted line indicates areas of the web page that you can select. Click the areas to convert. Selected areas
appear in blue boxes. To deselect an area, click it again. Proceed with conversion as usual. To deselect all
areas and exit the select mode, click Select again. Convert a linked web page to PDF In the open web page,
right-click the linked text and choose one of the following: If you select either of these options, the currently
open web page, not the selected link, is converted. For example, you can include an entire website in the PDF
or just some levels of a website. To change the number of levels in the website to convert, click Capture
Multiple Levels. Enter the number of levels to include, or select Get Entire Site to include all levels from the
website. Some websites have hundreds or even thousands of pages. Converting a large website can make your
system slow and unresponsive, and can even use up available hard drive space and memory, causing a system
crash. If Get Only N Level s is selected, select one or both of the following options: Stay On Same Server
Downloads only web pages stored on the same server. You can view PDF pages while they are downloading;
however, you cannot modify a page until the download process is complete. You do not need to wait for the
conversion to complete before adding more requests. While a conversion is in progress, you can convert
another page to PDF and that gets added to the queue. The number of requests in the queue are indicated by
the Pending Conversions field in the Download Status dialog box. If necessary, scroll to the page containing
links to the pages you want to add. Right-click the web link, and choose Append To Document. After pages
have been converted, links to these pages change to internal links, and clicking a link takes you to the PDF
page, rather than to the original HTML page on the web. If necessary, scroll to the page containing a web link
you want to convert. In Windows, you can also convert a linked page from a web page displayed in Internet
Explorer, Google Chrome, or Firefox, using a similar right-click command. Copy the URL of a web link Use
this procedure to copy the path for a web link to the clipboard, to use it for other purposes. Open the
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previously converted PDF in Acrobat. If necessary, scroll to the page containing links to the pages you want to
copy. Right-click the web link and choose Copy Link Location. Change web page conversion options The
settings for converting web pages to PDF apply to the conversion process. The settings changes do not affect
existing PDFs. Do one of the following: Click the Settings button to see additional options for the selected File
Type. On the Page Layout tab, select options for page size, orientation, and scaling, as needed. Choose a file
type and click Settings to select the font properties and other characteristics. If the page has no title, the URL
is used as the bookmark name. This structure lets you create tagged bookmarks for paragraphs, list elements,
and other items that use HTML elements. Headers show the web page title, or if no title is available, the web
page URL or file path. Footers show the web page URL or file path, and the date and time of the download.
Page Layout tab The Page Layout options specify a selection of page sizes and options for width, height,
margin measurements, and page orientation. The Scaling options are as follows: If this option is not selected,
the paper size adjusts to fit the contents of the page, if necessary. Switch To Landscape If Scaled Smaller Than
Changes the page orientation to landscape if the new version of a page is less than the specified percentage of
the original size. Available only if you selected portrait orientation. Default Encoding Lets you specify the
following options: Default Encoding Sets the input encoding of the file text from a menu of operating systems
and alphabets. Language Specific Font Settings Use these settings to change the language script, body text
typeface, and base typeface size. Default Colors Sets the default colors for text, page backgrounds, and web
links. Click the color button to open a palette and select the color. Multimedia Content Determines whether to
disable multimedia capture, embed multimedia files when possible, or link to multimedia such as SWF files by
URL. Retain Page Background Specifies whether to display colors and tiled images in page backgrounds and
colors in table cells. If options are deselected, converted web pages sometimes look different than they do in a
web browser, but are easier to read when printed. Underline Links Underlines textual web links on the pages.
Text Settings Sets the input encoding of the text for a file. Default Colors Sets the default colors for text and
page backgrounds. Click the color button to open a palette, and select the color. Wrap Lines At Margin Inserts
a soft return when the text reaches the edge of the text area on the page.
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4: Free Website Builder - Build Your Own Free Website - WebsiteBuilder
Web Page Maker is an easy-to-use webpage creation tool that allows you to create your own web pages even if you
donÂ´t know anything of HTML code. The program is based in the principles of drag&drop, so you can insert pictures,
text and navigation bars in a very easy way.

This page provides an in-depth overview of MLA format. It includes information related to MLA citations,
plagiarism, proper formatting for in-text and regular citations, and examples of citations for many different
types of sources. How to Be a Responsible Researcher or Scholar: Putting together a research project involves
searching for information, disseminating and analyzing information, collecting information, and repurposing
information. Being a responsible researcher requires keeping track of the sources that were used to help
develop your research project, sharing the information you borrowed in an ethical way, and giving credit to the
authors of the sources you used. Doing all of these things prevents plagiarism. There are many examples of
plagiarism. Changing or modifying quotes, text, or any work of another individual is also plagiarism. Believe
it or not, you can even plagiarize yourself! Re-using a project or paper from another class or time and saying
that it is new is plagiarism. One way to prevent plagiarism is to add citations in your project where
appropriate. What is a Citation? A citation shows the reader or viewer of your project where you found your
information. Citations are included in the body of a project when you add a quote into your project. These
citations that are found in the body of a research paper are called in-text, or parenthetical citations. These
citations are found directly after the information that was borrowed and are very brief in order to avoid
becoming distracted while reading a project. Included in these brief citations is usually just the last name of
the author and a page number or the year published. Scroll down below for an in-depth explanation and
examples of in-text and parenthetical citations. Look on the last page or part of a research project, where
complete citations can be found in their entirety. Complete citations are found on what is called an MLA
Works Cited page, which is sometimes called a bibliography. All sources that were used to develop your
research project are found on the Works Cited page. Complete citations are created for any quotes or
paraphrased information used in the text, but also any sources that helped you develop your research project.
Looking to create your citations in just a few clicks? Click here to see more across the site. Also, check out
this article to see MLA citation in the news. Why Does it Matter? Citing your sources is an extremely
important component of your research project. It also shows that you were able to locate appropriate and
reputable sources that helped back up your thesis or claim. In addition, if your work ends up being posted
online or in print, there is a chance that others will use your research project in their own work! Scroll down to
find directions on how to create citations. The Modern Language Association is an organization that was
created to develop guidelines on everything language and literature related. They have guidelines on proper
grammar usage and research paper layouts. In addition, they have English and foreign language committees,
numerous books and journal publications, and an annual conference. The Modern Language Association is
responsible for creating standards and guidelines on how to properly cite sources to prevent plagiarism. Their
style is most often used when writing papers and citing sources in the liberal arts and humanities fields.
Liberal arts is a broad term used to describe a range of subjects including the humanities, formal sciences such
as mathematics and statistics, natural sciences such as biology and astronomy, and social science such as
geography, economics, history, and others. The humanities specifically focuses on subjects related to
languages, art, philosophy, religion, music, theater, literature, and ethics. Believe it or not, there are thousands
of other types of citation styles. While this citation style is most often used for the liberal arts and humanities
fields, many other subjects, professors, and schools prefer citations and papers to be styled in MLA format.
Why do we use this style? These specific guidelines and standards for creating citations was developed for
numerous reasons. When scholars and researchers in the literature, language, and numerous other fields all cite
their sources in the same manner, it makes it easier for readers to look at a citation and recognize and
understand the different components of a source. From looking at a citation, we can see who the author is, the
title of the source, when it was published, and other identifiable pieces of information. Not only would it make
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it difficult to understand the source that was used, but it would also make it difficult for readers to locate it
themselves. How is the new version different than previous versions? This citation style has changed
dramatically over the past couple of years. Currently in its 8th edition, the 8th version is a citation style that is
much different than the previous formatting style. In the 7th version, which is the format, or structure, that was
previously used, researchers and scholars found it grueling to put their citations together. Each source used a
different citation structure. Researchers and scholars were required to look up the citation format that matched
the type of source they used. So, if a person used a book, a website, a journal article, a newspaper article, and
an e-book, all in one research project, they were required to look up how to cite each one of those sources
because each was structured differently. Now, with the new version of MLA formatting, which is version 8, all
source types use the same citation structure. The Modern Language Association enacted this new format due
to the many new and innovative ways of obtaining information. We are no longer receiving information
through traditional means, such as books, websites, and articles. We can now obtain information through apps,
advertisements, Tweets, other social media posts, and many other creative ways. To make the process of
creating citations easier for researchers and scholars, the Modern Language Association decided to have one
MLA citing format, which works for all source types. Other changes were made as well. A Deeper Look at
Citations What do they look like? There are two types of citations. There are regular or complete citations,
which are found at the end of research projects. Regular citations are generally placed in this MLA citation
format: Last name of the author, First name of the author. There are times when additional information is
added into the regular citation. Not sure how to transfer the information from your source into your citation?
See the next section to find out how to create in text citations. What are in text and parenthetical citations? As
stated above, in text citations, also called parenthetical citations, are included in the main part of a project
when using a quote or paraphrasing a piece of information from another source. We include these types of
citations in the body of a project for readers to quickly gain an idea as to where we found the information.
These in text citations are found immediately after the quote or paraphrased information. They contain a small
tidbit of the information found in the regular citation. The regular, or complete, citation is located at the end of
a project. Too much fire and you have a bad temper We want them to focus on our work and research, not
necessarily our sources. The regular citation, at the end of the project looks like this: The Joy Luck Club. If
your direct quote or paraphrase comes from a source that does not have page numbers, it is acceptable to place
a paragraph number use the abbreviation par. Use quotes from outside sources to help illustrate and expand on
your own points, but the majority of your paper should be your own writing and ideas. Include the quote
exactly as you found it. It is okay to pull and use only certain words or phrases from the quote, but keep the
words spelling and capitalization and punctuation the same. It is acceptable to break up a direct quote with
your own writing The entire paper should be double spaced, including quotes. If the quote is longer than four
lines, it is necessary to make a block quote. Block quotes show the reader that they are about to read a lengthy
amount of text from another source. Start the quote on the next line, half an inch in from the left margin Do
not use any indents at the beginning of the block quote Only use quotation marks if there are quotation marks
present in the source If there is more than one paragraph in the block quote, start the next paragraph with the
same half inch indent Add your in-text citation at the end of the block quote Example: And I saw you and
Mommy. Confused about whether footnotes and endnotes should be used? Footnotes and endnotes are not
used in this style. Use in-text, or parenthetical citations, in the body of your work. In addition, create full, or
regular citations, and place them at the end of your project on the Works Cited list. If you need help with in
text and parenthetical citations, Citation Machine can help. Specific Components of a Citation This section
explains each individual component of the citation, with examples for each section. A period closes this
information. When there are two authors that work together on a source, the author names are placed in the
order in which they appear on the source. Place their names in this format: Here are two examples of how to
cite two authors: Clifton, Mark, and Frank Riley. There are many times when three or more authors work
together on a source. This happens often with journal articles, edited books, and textbooks. To cite a source
with three or more authors, place the information in this format: The other authors are accounted for by using
et al.
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5: How to enlarge a web page | Digital Unite
Once you have downloaded a Web Page Maker installer or compressed archive, follow these instructions to install: 1.
Double click the www.enganchecubano.com installer to start the install.

6: Is it Possible to Use Microsoft Word or Office to Create a Website? If So, How? (www.enganchecubano.
How to Create a Simple Web Page with HTML. In this Article: Article Summary Creating the Web Page Saving and
Opening Your Web Page Sample HTML Community Q&A This wikiHow teaches you how to code a simple text web
page with HTML.

7: Convert HTML to PDF, HTML to PDF converter | Adobe Acrobat DC
With this tutorial video, I'm guiding you to make a wonderful webpage without any coding knowledge with web page
maker. Using this software & my tutorial, you can make a wonderful webpages in no time!

8: Web Page Maker - Free downloads and reviews - CNET www.enganchecubano.com
The core of a web page is a file written in Hypertext Markup Language (HTML). Typically, the HTML file includes
associations with other files that either appear on the web page or govern how it looks or works. When you convert a
web page to PDF, the HTML file and all associated filesâ€”such as JPEG.

9: MLA Format Citation Generator & Guide
SiteSpinner Free Web Page Maker SiteSpinner is our free Windows software that makes it easy for anyone to build and
publish a web page. With SiteSpinner drag-and-drop page builder you do not need to know any coding.
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